
This screencam provides a short demonstration of the design capabilities on Infoprint Designer
for iSeries.   We will simulate a typical output design application.  First, we will open a new
project.   The project structure not only facilitates the design process but also makes it simple to
put the completed design into proejction. In this example, the actual design process will start
with an overlay (electronic form).  We will bring in a partially completed overlay and step you
through the process of completing it.  Once the overlay is complete, we will then download
output data from a spool file located in an output queue on an iSeries server.  This will put us in
the standard design mode for Infoprint Designer with the application data in one window and the
page design in the other.   Application data is simply dragged and dropped onto the design page.
Any element on the design page, including the application data, can be modified.  This includes
modifiying position, orientation, font, barcoding, an so on. You can toggle back and forth
between data mapping mode and overlay mode.  You can also page through the application data,
viewing how it will be formatted, to verify that each page is the way you want it.  Once the
application design is complete, we will upload the project to your iSeries server.  All of the
individual resources required on the iSeries server (overlays, images, page definitions, and form
definitions) are uploaded and compiled.  The application is ready for production.  

The following sections take you step-by-step by the screencam demo. 

Create New Project 
We will start with creating a new project called DEMO1 in Infoprint Designer, by selecting the
File menu, then New Project.  The New Project window now displayed, gives a choice to start  
the project by creating an overlay definition or an layout definition.  We will select overlay
definition because we will be modifying an overlay, which is basically a static electronic form.
We will enter “Demo1” for the project name, then click on the Change button to select the
overlay file we would like to modify and click on OK to load the project.  

We will use the ALT + 5 keys to demonstrate the ability to display the full 8 1/2 x 11 inch
overlay on the screen.

Draw Box
We will draw a box to frame the Invoice, by selecting the Box icon and then anchoring the upper
left hand corner of the box as close as we can to .53” x .40” inches and dragging it down to
7.52”x 10.25”. Now that the box is drawn, we can right click on the box to bring up the Box
Properties window.  We will select the Rounding tab to change the Rounded corners option to
All and then click on OK to view the change. To demonstrate the ease in navigation we will
place the cursor on the form, then click on the Alt+3 keys to zoom into this area. 

Add Image
We will now go to the File menu, Get image to bring up the Get image window which allows
us to browse for an image.  We will select SS2TOP.300 and then place it on the form. (as close
as we can to .50”x.70”).
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Add Text and Align
We will now show you how to enter text and align it with a click of a button. Type in:  Ship Via:  
(around but not exact on .65”x3.30”) eyeball the rest...Shipped Date, Terms, Salesman. No we
will place the text and other objects using the Align button.  We will first select the multiple text
strings by using the Shift+Left mouse button.  Once all the objects are selected, we can click on
the Align button and then select the option that aligns the objects vertically to the characters
baseline. We will then select text objects to horizontally align them.

Element Repeat
Now we will show you the function that allows you to repeat multiple lines.  We start out by
selecting the line we would like to repeat and then select the Repeat button, which brings up the
Line Properties window.  Here we select the Repeat Automatically option and enter for a
Count of “3.” Next we select the option to draw the repeating lines down from the selected line
and click on OK.  In order to position the we will select the second line and then move this line
to 741 pels.  This will automatically space out the remaining lines so that there is equal space
between the lines.

The previous function we showed you will not work for creating the vertical lines used to
separate the columns of this invoice because the space between the lines are not equal, therefore
we will show how to copy lines efficiently. We start by selecting your CTRL key and using your
left mouse button to select and drag you new line to a new location.  Again, once you’ve drawn
several lines you can use the align function to assure proper alignment.

Format Text within Area
Another productivity feature of Infoprint Designer is the ability to create box text, then define
shading and justification to the text box.  We start by selecting the Text icon, then we draw a
box to define the text box area, we then simply type in the text, DESCRIPTION, then apply
shading and right click twice to get the Measured text properties window. We will select the
Alignment tab, and specify how you would like the text to appear, in this case we want it
centered, then click on OK to view the changes.

Add Watermark
We will now use the Get image command again to load and place a watermark in the center of
the form.

Add Arrows
Now we will show you a really great way to draw arrows.  We start by selecting the Box icon.
We then draw a small box.  Right click on the box to display the Box properties window.  Click
on the Line tab and change the pels to zero, then click on the Shading tab and from the
Diagonals pull down select the option for Both, then deselect the Whole option and select the
Left option to display Xdark.  Note that a preview of the box displays in the Box Properties
window.  Click on and we’re ready to re-size the arrow on the fly.

Grouping
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The next function we will be demonstrating will show you how easy it is to group and ungroup
objects so you can control them as a one object.  We will start by selecting the arrow we just
drew, then the text and the shaded box. Next, we will select the Group icon.  Note when these
different objects are a  group. they move as one.  If you need to adjust a unit of the group, simply
ungroup the objects and adjust as needed. Now that we finished our overlay we will save the
design.

Get iSeries Data
Now we will be downloading sample data from the iSeries Server, Since we started this project
in overlay mode, we now simple click on the Layout tab, which them brings up the Data
window which prompts us to whether we will using data from the PC or AS/400.  We will
choose the AS/400 option.  With the Get sample data - Select an output queue window
displayed,  we will enter the name of the output queue where the spool file we prepared for this
demonstration is, and click OK. The Select a spooled file window will now display and we will
select the spooled file named INVNEW.  Since there are only six pages to this job, we will
download the complete file.  If your spool files are very large, you may enter the number of
pages you would like to download to use as your sample data file on this window. Click OK.   
The Select line data file window will now appear to give us the opportunity to save the file to
our PC.  We will save the sample data file on our PC and call it demo.dat, then click on the Save
button to start the download process.  Once the download process is complete, note the Data
Window with the sample data file displays on the right side of the View/Edit window with the
template displayed ready for mapping of the data.

Drag and Drop Data
We will use the Zoom in button to zoom into the top of template in the View/Edit window.
Now we will start by selecting the Sold To address block in the Data Window by using the left
mouse button to select the data, then the right mouse button to drag and drop the selected data
and position it onto the template in the View/Edit window. Select the Zip code field again, then
drag and drop it on to the template.  We will now edit the Zip code field by using the right mouse
button to open the Field Properties window.  Next we will click on the Bar Code button to
open the Bar Code Options window, where we can enter a name for the bar code and select
which bar code we would like to use.  For this example we will select the Postnet bar code and
then click on OK twice. We will now quickly map the rest of fields to fill out the top of the
template.  Note how we can use the cross hairs to guide us in the placement of data to the
template.  We also have the ability for snapping to a user defined grid. We will now use the Next
button to scroll through the data in order to preview our job.

Changing Data Attributes
Now it’s time to show the ability to map individuals fields of a repeating printline.  We will start
off by selecting the Quantity column of the sample data, then drag and drop it to place it on to
the template.  Note that the data in the quantity is center justified.  We will change the font used
here to a fixed pitch font so the numbers are right justified.  We right click on the field to bring
up the Field Properties window.  We will select the Font 1 tab, which allows us to select
Courier Latin 1, which is a fixed pitch font, and then the proper Code Page, then click on OK.
We will now map the rest of columns, repeating the font change for the Price and Extension
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columns.   Note that you have the ability to reposition items after you dropped them on to the
template in the View/Edit window by using the left mouse button and drag and drop it to it’s
new position.  You can also select the field and change it’s coordinates on the top right side of
the Infoprint Designer.  Now that we have placed all the columns, we will use the scroll buttons
in the Data Window to view the rest of the data.  Note that the Description column of the data
contains a message that should appear in this box.  To change the number of the repeating
printlines, we will simply use the right mouse button to select a field in the description column.
This will bring up the Field Properties window.  We will select the Printline properties button,
which allows us to enter the number of times we want a printline to repeat.  We will randomly
enter “20” in the Repeat  field and click on OK twice.  Note that this change is immediately
reflected in the View/Edit window.  We will repeat this step in order to map the full message.
Now that full message is mapped we can show how easy it is in Infoprint Designer to adjust the
line spacing between printlines even after they we mapped each column as individual fields.  We
will simply use the CTRL + the left mouse button on a field then drag that line vertically until
we satisfied with the spacing.  In this demonstration I exaggerate the movement in order to make
this great feature more visible.

We will map the total field and then use the Next button on the top left side of the Infoprint
Designer to scroll through the data. As we scroll through the data, we notice that we are
dropping part of the total field, therefore we need to modify the the start byte and length of a
field.  We can do so by simply using a right click on the field to open the Field Properties
window.  We will change the Start byte field to 70 and the Length field to 10.  Now as we scroll
through the data to proof the document on the screen.

Upload to iSeries
Now that we have completed the project, we are ready for uploading the project to the iSeries
server.  Select the File menu, Upload to AS/400.  In Upload to AS/400 window, we will select
Whole project, then click on OK to start the upload process.  This will automatically upload all
the components needed to print this job.  In Infoprint Designer you can change your setting to
only upload specific items of the job if you desire.  You also have the ability to specify whether
prefixes are used or discarded on individual resources.  

Now you’re ready to print!
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